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Manage Website Pages & Files 

Manage Website Pages 

Page Types Definitions 

 Dynamic Module: A dynamic module provides you with a template based page structure. This
provides you a more efficient process of entering content while maintaining organizational and
format consistency within the page.

 Static Page: A web page that is delivered to the user exactly as stored, in contrast to dynamic
module pages which are generated by the website.

 Static Link: Static Link will create a navigational link within the website but redirect the user to
another destination or file located within your website or redirect the user to another website.

Creating a New Page 

Creating a Static Page 

1. From the main page of the administrative website, select your website, located under the

Manage Websites box.

2. Select New Page located on the upper right of the page.
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General Tab 

General Details 

1. Enter the Name of your page.

2. Under the Type dropdown list, select ‘Static Page’.

3. Under the System Page drop down, select ‘Yes’ if you want to make this page harder to delete,

otherwise select ‘No’. In case that you selected ‘Yes’ and you want to delete this page, you need

to change this field to ‘No’ and then delete the page.
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4. Under the Enabled drop down, select ‘Yes’ if you want this page to be available in your website.

Otherwise, select ’No’.

Navigation 

1. Under the Show in Navigation dropdown, select ‘Yes’ if you want people to be able to navigate

to your page from your website menu, or select ‘No’ if you want the page to be hidden, meaning

a person would require the page URL in order to find the page.
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2. The Breakpoints are only available if the design of your website is responsive. By selecting all

the types (mobile, tablet and pc), your website will respond according the device that a visitor

uses.

3. Enter a Navigation Name for the page. If nothing is entered, the page name will also become the

navigation name by default.
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4. Select ‘Yes’ under the Default Page dropdown if you want this page to become the Homepage

of your website. In this case, this field in your current Homepage will automatically be set to

‘No’.

Page Content 

1. Enter your page content in the Page Content section.

Notes:

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.
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Content Optimization 

1. Enter the Windows Title. This text appears at the top of a user’s web browser when viewing this

page.

2. Enter the Alias field. This feature allows you to provide a more understandable name to your

page on the page URL.
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3. Select ‘Yes’ under the Visible to Search Engines dropdown if you want your page to be visible to

search engines.

4. Enter a Meta Description for your page. This description is used on search engine result pages

(SERPs) to display preview snippets for your page.
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Save/Save and Publish 

1. Click Save if you want to save your page but not publish it yet or click Save and Publish if you

want to make your page available to the website visitors.
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Approval Tab 

Under the Approval tab, the administrator is able to manage the editors of this page. 

Managing Access Rights 

Next to the name of each group, check the access rights that the users of this group will have on 

this page. You can give either ‘Editor’ or ‘Publisher’ access to the group or both. If you do not 

check any box, then the specific group will have just Author access. 

2. Click Save at the bottom of the page.
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Permissions Tab 

Under the Permissions tab you are able to define who will be able to view this page. 

Managing Permissions 

Under the Access Is dropdown list, either give access to any user by selecting ‘Public’ option or 

limit the access by selecting ‘Limited’. 

Access Is: Public 

If you selected ‘Public’ under the Access Is dropdown: 

1. Under the Show in Navigation dropdown, select either ‘Yes’ or ‘No’. Note that there is another

Show in Navigation dropdown box in the General tab. In order to set up this setting correctly,

you need to have in mind the following rules:

a. If you selected ‘Yes’ in the General Tab and ‘No’ in the Permissions tab, the page will

not be shown in Navigation.

a. If you selected ‘No’ in the Generals Tab and ‘Yes’ in the Permissions tab, the page will

not be shown in Navigation.

b. If you selected ‘No’ in both tabs, the page will not be shown in Navigation

c. If you selected ‘Yes’ in both tabs, the page will be shown in Navigation.
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2. Click Save at the bottom of the page.

Access Is: Limited 

If you selected ‘Limited’ under the Access Is dropdown list: 

1. Under the To dropdown list, select one of the following options:

a. ‘ANY User’: This means that nobody will have access to this page.

b. ‘Users with AT LEAST ONE of the selected roles’: In this case you will be asked to specify

the user roles. The page will be available to the users that have at list one of the

selected roles.

c. ‘Users with ALL of the selected roles’: At this case you will be asked to specify the user

roles. The page will be available to the users that have all the selected roles.

2. If you selected either ‘Users with AT LEAST ONE of the selected roles’ or ‘Users with ALL of the

selected roles’, specify the selected roles by checking the box next to the roles to which you wish

to minimize the access:
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3. Under the On Permission Denied dropdown, select what kind of message will be displayed in

case of a denied access. You can choose either the default message by selecting ‘Display the

default permission denied page’ or

4. If you selected ‘Display a Custom error message’ under the On Permission Denied dropdown,

select the custom message that you wish to be displayed.



 15 | P a g e

5. Under the Show in Navigation dropdown, select either ‘Yes’ or ‘No’. Note that there is another

Show in Navigation dropdown box in the General tab. In order to set up this setting correctly,

you need to have in mind the following rules:

a. If you selected ‘Yes’ in the General Tab and ‘No’ in the Permissions tab, the page will

not be shown in Navigation.

b. If you selected ‘No’ in the Generals Tab and ‘Yes’ in the Permissions tab, the page will

not be shown in Navigation.

c. If you selected ‘No’ in both tabs, the page will not be shown in Navigation

d. If you selected ‘Yes’ in both tabs, the page will be shown in Navigation.

6. Click Save at the bottom of the page.
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Links Tab 

Under the Links tab you are able to create links to be displayed on your page as related links. These links 

can be external websites, pages of your website or website files. 

Creating a Link 

1. Select New Link that is located next to the yellow star on the upper right of the page.

2. Enter, into the Name field, the name of the link, which is how it will be displayed on your page.

3. Enter, into the Website field, the link that you want to be displayed. This can be either a link or a

file.

 In case that the link is an external website, type the link of the website.

 In case that the link will be a website file or a website page, use the link button at the right
of the website field.
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a. On the pop up page, select either Link to Page or Link to File tab and select the page

or a file you wish to add as a link.

b. If you want to remove your selection, use the remove button at the right of the

Website field.

4. Under the Open With dropdown, indicates whether you want this link to open in a ‘New

Window’ or in the ‘Same Window’.

5. Click Save at the bottom of the page.
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Editing a Link 

1. Select the Pencil icon located to the right of the link you wish to edit.

2. Edit the link fields.

3. Once you have made the desired changes, click Save at the bottom of the page.

Removing a Link 

1. Select the Trash icon located to the right of the link you wish to remove.

2. You will be asked to confirm that you wish to remove the link. Click OK.
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Documents Tab 

Under the Documents tab you are able to enter documents to be displayed on your page. 

Creating a Document 

1. Select New Document that is located next to the yellow star on the upper right of the page.

2. Enter, into the Name field, the name of the document, which is how the document will be

displayed on your page.

3. Click Choose a File to select a file located in your PC. Under the button you can view the

different file formats that you can select. In case that you want to replace the document you

chose, just click the button again and select another document.

4. Click Save at the bottom of your page.
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Editing a Document 

1. Select the Pencil icon located to the right of the document you wish to edit.

2. Edit the document fields.

3. Once you have made the desired changes, click Save at the bottom of the page.

Removing a Document 

1. Select the Trash icon located to the right of the document you wish to remove.

2. You will be asked to confirm that you wish to remove the document. Click OK.
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Page Content Boxes Tab 

Under the Page Content Boxes tab you are able to create content boxes to be displayed on your page. 

Creating a Page Content Box 

1. Select New Page Content Box that is located next to the yellow star on the upper right of the

page.

General Details 

1. Enter, into the Internal Title field, the name of the content box.

2. Under the Type dropdown menu select the type of the content box which can be either ‘Image

and Link’ or ‘Text’.
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3. Under the Location dropdown menu select the location of the content box on the screen which

can be either at the ‘Right Column’ or at the ‘Left Column’.

Type: Image and Link 

If you selected ‘Image and Link’ as the type of the content box: 

1. Click Choose a File to select an email located in your PC. Under the button you can view the

different image formats that you can select. In case that you want to replace the image you

chose, just click the button again and select another image.

2. Enter, into the Website field, the link that you want to be displayed. This can be either a link or a

file.

 In case that the link is an external website, type the link of the website.

 In case that the link will be a website file or a website page, use the link button at the right
of the website field.
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a. From the pop up page, select either Link to Page or Link to File tab and select the

page or a file you wish to add as a link.

b. If you want to remove your selection, use the remove button at the right of the

Website field.

3. Under the Open With dropdown, indicates whether you want this link to open in a ‘New

Window’ on in the ‘Same Window’.

4. Click Save at the bottom of your page.
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Type: Text 

If you selected ‘Text’ as the type of the content box 

 Enter the text you wish to be displayed into the content box in the Text section. 

Notes: 

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.

Click Save at the bottom of your page. 
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Editing a Page Content Box 

1. Select the Pencil icon located to the right of the content box you wish to edit.

2. Edit the content box fields.

3. Once you have made the desired changes, click Save at the bottom of the page.

Removing a Page Content Box 

1. Select the Trash icon located to the right of the content box you wish to remove.

2. You will be asked to confirm that you wish to remove the content box. Click OK.
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Creating a Dynamic Page 

1. From the main page of the administrative website, select your website, located under the

Manage Websites box.

2. Select New Page located on the upper right of the page.

General Tab 

General Details 

1. Enter the Name of your page.

2. Under the Type dropdown list, select ‘Dynamic Module’.
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3. Under the Module drop down, select the dynamic module that this page will be connected to.

4. Under the System Page drop down, select ‘Yes’ if you want to make this page harder to delete,

otherwise select ‘No’. In case that you selected ‘Yes’ and you want to delete this page, you need

to change this field to ‘No’ and then delete the page.
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5. Under the Enabled drop down, select ‘Yes’ if you want this page to be available in your website.

Otherwise, select ’No’.

Navigation 

1. Under the Show in Navigation dropdown, select ‘Yes’ if you want people to be able to navigate

to your page from your website menu, or select ‘No’ if you want the page to be hidden, meaning

a person would require the page URL in order to find the page.
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2. The Breakpoints are only available if the design of your website is responsive. By selecting all

the types (mobile, tablet and pc), your website will respond according the device that a visitor

uses.

3. Enter a Navigation Name for the page. If nothing is entered, the page name will also become the

navigation name by default.
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4. Select ‘Yes’ under the Default Page dropdown if you want this page to become the Homepage

of your website. In this case, this field in your current Homepage will automatically be set to

‘No’.

Header Content 

1. Enter the content of the page’s header under the Header Content section. This content will be

available before all the dynamic entries that will be created for your page.

Notes:

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.



 31 | P a g e

Footer Content 

1. Enter the content of the page’s footer under the Footer Content section. This content will be

available after all the dynamic entries that will be created for your page.

Notes:

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.
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Content Optimization 

1. Enter the Windows Title. This text appears at the top of a user’s web browser when viewing this

page.

2. Enter the Alias field. This feature allows you to provide a more understandable name to your

page on the page URL.

3. Select ‘Yes’ under the Visible to Search Engines dropdown if you want your page to be visible to

search engines.
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4. Enter a Meta Description for your page. This description is used on search engine result pages

(SERPs) to display preview snippets for your page.

Save/Save and Publish 

1. Click Save if you want to save your page but not publish it yet or click Save and Publish if you

want to make your page available to the website visitors.
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Approval Tab 

Under the Approvals tab, the administrator is able to manage the editors of this page. 

Managing Access Rights 

Next to the name of each group, check the access rights that the users of this group will have for 

this page. You can give either ‘Editor’ or ‘Publisher’ access to the group or both. If you do not 

check any box, then the specific group will have just Author access. 

 Click Save at the bottom of the page. 

Permissions Tab 

Under the Permissions tab you are able to define who will be able to view this page. 

Managing Permissions 

Under the Access Is dropdown list, either give access to any user by selecting ‘Public’ option or 

limit the access by selecting ‘Limited’. 
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Access Is: Public 

If you selected ‘Public’ under the Access Is dropdown: 

Under the Show in Navigation dropdown, select either ‘Yes’ or ‘No’. Note that there is another 

Show in Navigation dropdown box in the General tab. In order to set up this setting correctly, 

you need to have in mind the following rules: 

 If you selected ‘Yes’ in the General Tab and ‘No’ in the Permissions tab, the page will not be

shown in Navigation.

 If you selected ‘No’ in the Generals Tab and ‘Yes’ in the Permissions tab, the page will not be

shown in Navigation.

 If you selected ‘No’ in both tabs, the page will not be shown in Navigation.

 If you selected ‘Yes’ in both tabs, the page will be shown in Navigation.

Click Save at the bottom of the page. 

Access Is: Limited 

If you selected ‘Limited’ under the Access Is dropdown list: 

Under the To dropdown list, select one of the following options: 

 ‘ANY User’: This means that nobody will have access to this page.

 ‘Users with AT LEAST ONE of the selected roles’: At this case you will be asked to specify the

user roles. The page will be available to the users that have at list one of the selected roles.
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 ‘Users with ALL of the selected roles’: At this case you will be asked to specify the user roles. The

page will be available to the users that have all the selected roles.

If you selected either ‘Users with AT LEAST ONE of the selected roles’ or ‘Users with ALL of the 

selected roles’, specify the selected roles by checking the box next to the roles to which you wish 

to minimize the access: 

Under the On Permission Denied dropdown, select what kind of message will be displayed in 

case of a denied access. You can choose either the default message by selecting ‘Display the 

default permission denied page’ or  
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If you selected ‘Display a Custom error message’ under the On Permission Denied dropdown, 

select the custom message that you wish to be displayed. 

Under the Show in Navigation dropdown, select either ‘Yes’ or ‘No’. Note that there is another 

Show in Navigation dropdown box in the General tab. In order to set up this setting correctly, 

you need to have in mind the following rules: 

 If you selected ‘Yes’ in the General Tab and ‘No’ in the Permissions tab, the page will not

be shown in Navigation.

 If you selected ‘No’ in the Generals Tab and ‘Yes’ in the Permissions tab, the page will

not be shown in Navigation.

 If you selected ‘No’ in both tabs, the page will not be shown in Navigation
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 If you selected ‘Yes’ in both tabs, the page will be shown in Navigation.

 Click Save at the bottom of the page. 

Page Content Boxes Tab 

Under the Page Content Boxes tab you are able to create content boxes to be displayed on your page. 

Creating a Page Content Box 

Select New Page Content Box that is located next to the yellow star on the upper right of the 

page. 

General Details 

Enter, into the Internal Title field, the name of the content box. 



 39 | P a g e

Under the Type dropdown menu select the type of the content box which can be either ‘Image 

and Link’ or ‘Text’. 

Under the Location dropdown menu select the location of the content box on the screen which 

can be either at the ‘Right Column’ or at the ‘Left Column’. 

Type: Image and Link 

If you selected ‘Image and Link’ as the type of the content box: 

Click Choose a File to select an email located in your PC. Under the button you can view the 

different image formats that you can select. In case that you want to replace the image you 

chose, just click the button again and select another image. 
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Enter, into the Website field, the link that you want to be displayed. This can be either a link or a 

file. 

 In case that the link is an external website, type the link of the website.

 In case that the link will be a website file or a website page, use the link button at the right
of the website field.

a. From the pop up page, select either Link to Page or Link to File tab and select the

page or a file you wish to add as a link.
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b. If you want to remove your selection, use the remove button at the right of the

Website field.

Under the Open With dropdown, indicates whether you want this link to open in a ‘New 

Window’ on in the ‘Same Window’. 

Click Save at the bottom of your page. 

Type: Text 

If you selected ‘Text’ as the type of the content box 

Enter the text you wish to be displayed into the content box in the Text section. 

Notes: 

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.
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2. Click Save at the bottom of your page.
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Editing a Page Content Box 

Select the Pencil icon located to the right of the content box you wish to edit. 

Edit the content box fields. 

 Once you have made the desired changes, click Save at the bottom of the page. 

Removing a Page Content Box 

Select the Trash icon located to the right of the content box you wish to remove. 

You will be asked to confirm that you wish to remove the content box. Click OK. 
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Creating a Static Link 

From the main page of the administrative website, select your website, located under the 

Manage Websites box.  

Select New Page located on the upper right of the page. 

General Tab 

General Details 

Enter the Name of your page. 

Under the Type dropdown list, select ‘Static Link’. 
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Enter, into the Website field, the link that you want to be displayed. This can be either a link or a 

file. 

 In case that the link is an external website, type the link of the website.

 In case that the link will be a website file or a website page, use the link button at the right
of the website field.
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a. From the pop up page, select either Link to Page or Link to File tab and select the

page or a file you wish to add as a link.

b. If you want to remove your selection, use the remove button at the right of the

Website field.
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Under the Open With dropdown, indicates whether you want this link to open in a ‘New 

Window’ or in the ‘Same Window’. 

Under the System Page drop down list, select ‘Yes’ if you want to be able to delete the page, 

otherwise leave it as ‘No’. If you mark ‘Yes’, whenever you want to delete the page, you must 

edit the page and set this field to ‘No’. 

Under the Enabled dropdown, select ‘Yes’ if you want the page to be available on your website, 

or ‘No’ if you plan to enable the page at a later date. 

Navigation 

1. Under the Show in Navigation dropdown, select ‘Yes’ if you want people to be able to navigate

to your page from your website menu, or select ‘No’ if you want the page to be hidden, meaning

a person would require the page URL in order to find the page.
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2. The Breakpoints are only available if the design of your website is responsive. By selecting all

the types (mobile, tablet and pc), your website will respond according the device that a visitor

uses.

3. Enter a Navigation Name for the page. If nothing is entered, the page name will also become the

navigation name by default.

4. Select ‘Yes’ under the Default Page dropdown if you want this page to become the Homepage

of your website. In this case, this field in your current Homepage will automatically be set to

‘No’.
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Content Optimization 

1. Enter the Windows Title. This text appears at the top of a user’s web browser when viewing this

page.

2. Enter the Alias field. This feature allows you to provide a more understandable name to your

page on the page URL.
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3. Select ‘Yes’ under the Visible to Search Engines dropdown if you want your page to be visible to

search engines.

4. Enter a Meta Description for your page. This description is used on search engine result pages

(SERPs) to display preview snippets for your page.
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Save/Save and Publish 

1. Click Save if you want to save your page but not publish it yet or click Save and Publish if you

want to make your page available to the website visitors.
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Editing a Page 

Editing a Static Page 

In the case that you selected Static Module for the type of your page, you can use the following 

instructions to setup your page. 

From the main page of the administrative website, select your website, located under the 

Manage Websites box.  

Find the page you wish to edit and select the Pencil icon located to the right of the page. 

 At this point you will be able to edit your page 

General Tab 

General Details 

Under the System Page, select ‘Yes’ if you want to be able to delete the page, otherwise leave it 

as ‘No’. If you mark ‘Yes’, whenever you want to delete the page, you must edit the page and set 

this field to ‘No’. 

Under the Enabled dropdown, select ‘Yes’ if you want the page to be available on your website, 

or ‘No’ if you plan to enable the page at a later date. 
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Navigation 

Under the Show in Navigation dropdown, select ‘Yes’ if you want people to be able to navigate 

to your page, or select ‘No’ if you want the page to be hidden, meaning a person would require 

the page URL in order to find the page.  

Enter a Navigation Name for the page. If nothing is entered, the page name will also become the 

navigation name by default.  

Default Page can be left as ‘No’. 



 54 | P a g e

Page Content 

Enter your page content in the Page Content section. 

Notes: 

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.

Content Optimization 

1. It is recommended that you leave the content optimization fields as is. However, you can add a

Meta Description for your page which will be used by the search engines.

Windows Title: This text appears at the top of a user’s web browser when viewing this page. 



 55 | P a g e

Alias: This feature allows you to provide a more understandable name to your page on the page 
URL. 
Visible to Search Engines: Select ‘Yes’ if you want your page to be visible to search engines. 
Meta Description: This description is used on search engine result pages (SERPs) to display 
preview snippets for your page. 

Version Control 

1. Use the version control if you would like to view any of the previews revisions of your page.

If the current editing of your page is an important change, select ‘No’ under the This is a minor

edit dropdown.

Approve and Publish 

1. You can view the Status of the page and the Actions you have to do to make the page available

to people. The Actions can be ‘Approve Page’, in case that the page is not approved, and

‘Publish Page’ in case that the page is not published.



 56 | P a g e

Preview this Page 

At any point while you are editing your page, you can always preview it by selecting the Preview 

this Page button at the very bottom of the page. 

Save or Save and Publish 

Once you are finished editing the page, scroll to the very bottom of the page and click Save to 

save the changes you have made without publishing them to your website, or click Save and 

Publish to have the changes published to your live website.  
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Approval Tab 

Under the Approvals tab the administrator is able to manage the editors of this page. 

Managing Access Rights 

Next to the name of each group, check the access rights that the users of this group will have for 

this page. You can give either ‘Editor’ or ‘Publisher’ access to the group or both. If you do not 

check any box, then the specific group will have just Author access. 

 Click Save at the bottom of the page. 

Permissions Tab 

Under the Permissions tab you are able to define who will be able to view this page. 
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Managing Permissions 

Under the Access Is dropdown list, either give access to any user by selecting ‘Public’ option or 

limit the access by selecting ‘Limited’. 

Access Is: Public 

If you selected ‘Public’ under the Access Is dropdown: 

Under the Show in Navigation dropdown, select either ‘Yes’ or ‘No’. Note that there is another 

Show in Navigation dropdown box in the General tab. In order to set up this setting correctly, 

you need to have in mind the following rules: 

a. If you selected ‘Yes’ in the General Tab and ‘No’ in the Permissions tab, the page will

not be shown in Navigation.

b. If you selected ‘No’ in the Generals Tab and ‘Yes’ in the Permissions tab, the page will

not be shown in Navigation.

c. If you selected ‘No’ in both tabs, the page will not be shown in Navigation

d. If you selected ‘Yes’ in both tabs, the page will be shown in Navigation.

Click Save at the bottom of the page. 

Access Is: Limited 

If you selected ‘Limited’ under the Access Is dropdown list: 

Under the To dropdown list, select one of the following options: 

 ‘ANY User’: This means that nobody will have access to this page.
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 ‘Users with AT LEAST ONE of the selected roles’: At this case you will be asked to specify the

user roles. The page will be available to the users that have at list one of the selected roles.

 ‘Users with ALL of the selected roles’: At this case you will be asked to specify the user roles.

The page will be available to the users that have all the selected roles.

If you selected either ‘Users with AT LEAST ONE of the selected roles’ or ‘Users with ALL of the 

selected roles’, specify the selected roles by checking the box next to the roles to which you wish 

to minimize the access: 
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Under the On Permission Denied dropdown, select what kind of message will be displayed in 

case of a denied access. You can choose either the default message by selecting ‘Display the 

default permission denied page’ or  

If you selected ‘Display a Custom error message’ under the On Permission Denied dropdown, 

select the custom message that you wish to be displayed. 
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Under the Show in Navigation dropdown, select either ‘Yes’ or ‘No’. Note that there is another 

Show in Navigation dropdown box in the General tab. In order to set up this setting correctly, 

you need to have in mind the following rules: 

a. If you selected ‘Yes’ in the General Tab and ‘No’ in the Permissions tab, the page will

not be shown in Navigation.

b. If you selected ‘No’ in the Generals Tab and ‘Yes’ in the Permissions tab, the page will

not be shown in Navigation.

c. If you selected ‘No’ in both tabs, the page will not be shown in Navigation

d. If you selected ‘Yes’ in both tabs, the page will be shown in Navigation.

Click Save at the bottom of the page. 
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Links Tab 

Under the Links tab you are able to create links to be displayed on your page as related links. These links 

can be external websites, pages of your website or website files. 

Creating a Link 

Select New Link that is located next to the yellow star on the upper right of the page. 

Enter, into the Name field, the name of the link, which is how it will be displayed on your page. 

Enter, into the Website field, the link that you want to be displayed. This can be either a link or a 

file. 

 In case that the link is an external website, type the link of the website.

 In case that the link will be a website file or a website page, use the link button at the right
of the website field.
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a. From the pop up page, select either Link to Page or Link to File tab and select the

page or a file you wish to add as a link.

b. If you want to remove your selection, use the remove button at the right of the

Website field.

Under the Open With dropdown, indicates whether you want this link to open in a ‘New 

Window’ on in the ‘Same Window’. 

Click Save at the bottom of the page. 



 64 | P a g e

Editing a Link 

Select the Pencil icon located to the right of the link you wish to edit. 

Edit the link fields. 

 Once you have made the desired changes, click Save at the bottom of the page. 

Removing a Link 

Select the Trash icon located to the right of the link you wish to remove. 

2. You will be asked to confirm that you wish to remove the link. Click OK.
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Documents Tab 

Under the Documents tab you are able to enter documents to be displayed on your page. 

Creating a Document 

Select New Document that is located next to the yellow star on the upper right of the page. 

Enter, into the Name field, the name of the document, which is how it will be displayed on your 

page. 

Click Choose a File to select a file located in your PC. Under the button you can view the 

different file formats that you can select. In case that you want to replace the document you 

chose, just click the button again and select another document. 

Click Save at the bottom of your page. 
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Editing a Document 

1. Select the Pencil icon located to the right of the document you wish to edit.

2. Edit the document fields.

3. Once you have made the desired changes, click Save at the bottom of the page.

Removing a Document 

1. Select the Trash icon located to the right of the document you wish to remove.

2. You will be asked to confirm that you wish to remove the document. Click OK.
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Page Content Boxes Tab 

Under the Page Content Boxes tab you are able to create content boxes to be displayed on your page. 

Creating a Page Content Box 

Select New Page Content Box that is located next to the yellow star on the upper right of the 

page. 

General Details 

Enter, into the Internal Title field, the name of the content box. 

Under the Type dropdown menu select the type of the content box which can be either ‘Image 

and Link’ or ‘Text’. 
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Under the Location dropdown menu select the location of the content box on the screen which 

can be either at the ‘Right Column’ or at the ‘Left Column’. 

Type: Image and Link 

If you selected ‘Image and Link’ as the type of the content box: 

1. Click Choose a File to select an email located in your PC. Under the button you can view the

different image formats that you can select. In case that you want to replace the image you

chose, just click the button again and select another image.

2. Enter, into the Website field, the link that you want to be displayed. This can be either a link or a

file.

 In case that the link is an external website, type the link of the website.

 In case that the link will be a website file or a website page, use the link button at the right
of the website field.
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a. From the pop up page, select either Link to Page or Link to File tab and select the

page or a file you wish to add as a link.

b. If you want to remove your selection, use the remove button at the right of the

Website field.

3. Under the Open With dropdown, indicates whether you want this link to open in a ‘New

Window’ on in the ‘Same Window’.

4. Click Save at the bottom of your page.
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Type: Text 

If you selected ‘Text’ as the type of the content box 

 Enter text you wish to be displayed into the content box in the Text section. 

Notes: 

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.

Click Save at the bottom of your page. 
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Editing a Page Content Box 

1. Select the Pencil icon located to the right of the content box you wish to edit.

2. Edit the content box fields.

3. Once you have made the desired changes, click Save at the bottom of the page.

Removing a Page Content Box 

1. Select the Trash icon located to the right of the content box you wish to remove.

2. You will be asked to confirm that you wish to remove the content box. Click OK.
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Editing a Dynamic Page 

In the case that you selected Dynamic Module for the type of your page, you can use the following 

instructions to setup your page. 

1. From the main page of the administrative website, select your website, located under the

Manage Websites box. In the Manage Website box you are able to view all your websites.

2. Find the page you wish to edit and select the Pencil icon located to the right of the page.

3. At this point you will be able to edit your page

General Tab 

General Details 

1. Under the System Page, select ‘Yes’ if you want to be able to delete the page, otherwise leave it

as ‘No’. If you mark ‘Yes’, whenever you want to delete the page, you must edit the page and set

this field to ‘No’.

2. Under the Enabled dropdown, select ‘Yes’ if you want the page to be available on your website,

or ‘No’ if you plan to enable the page at a later date.
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Navigation 

1. Under the Show in Navigation dropdown, select ‘Yes’ if you want people to be able to navigate

to your page, or select ‘No’ if you want the page to be hidden, meaning a person would require

the page URL in order to find the page.

2. Enter a Navigation Name for the page. If nothing is entered, the page name will also become

the navigation name by default.

3. Default Page can be left as ‘No’.
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Header Content 

1. Enter the content of the page’s header under the Header Content section. This content will be

available before all the dynamic entries that will be created for your page.

2. Notes:

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.

Footer Content 

1. Enter the content of the page’s footer under the Footer Content section. This content will be

available after all the dynamic entries that will be created for your page.

2. Notes:

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.
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Content Optimization 

It is recommended that you leave the content optimization fields as is. However, you can add a 

Meta Description for your page which will be used by the search engines. 
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Version Control 

Use the version control if you would like to view any of the previews revisions of your page. 

If the current editing of your page is an important change, select ‘No’ under the This is a minor 

edit dropdown. 

Approve and Publish 

You can view the Status of the page and the Actions you have to do to make the page available 

to people. The Actions can be ‘Approve Page’, in case that the page is not approved, and 

‘Publish Page’ in case that the page is not published. 
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Preview this Page 

At any point while you are editing your page, you can always preview it by selecting the Preview 

this Page button at the very bottom of the page. 

Save/Save and Publish 

Once you are finished editing the page, scroll to the very bottom of the page and click Save to 

save the changes you have made without publishing them to your website, or click Save and 

Publish to have the changes published to your live website.  
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Approval Tab 

Under the Approvals tab the administrator is able to manage the editors of this page. 

Managing Access Rights 

Next to the name of each group, check the access rights that the users of this group will have for 

this page. You can give either ‘Editor’ or ‘Publisher’ access to the group or both. If you do not 

check any box, then the specific group will have just Author access. 

Click Save at the bottom of the page. 
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Permissions Tab 

Under the Permissions tab you are able to define who will be able to view this page. 

Managing Permissions 

Under the Access Is dropdown list, either give access to any user by selecting ‘Public’ option or 

limit the access by selecting ‘Limited’. 

Access Is: Public 

If you selected ‘Public’ under the Access Is dropdown: 

Under the Show in Navigation dropdown, select either ‘Yes’ or ‘No’. Note that there is another 

Show in Navigation dropdown box in the General tab. In order to set up this setting correctly, 

you need to have in mind the following rules: 

a. If you selected ‘Yes’ in the General Tab and ‘No’ in the Permissions tab, the page will

not be shown in Navigation.

b. If you selected ‘No’ in the Generals Tab and ‘Yes’ in the Permissions tab, the page will

not be shown in Navigation.

c. If you selected ‘No’ in both tabs, the page will not be shown in Navigation

d. If you selected ‘Yes’ in both tabs, the page will be shown in Navigation.
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Click Save at the bottom of the page. 

Access Is: Limited 

If you selected ‘Limited’ under the Access Is dropdown list: 

Under the To dropdown list, select one of the following options: 

a. ‘ANY User’: This means that nobody will have access to this page.

b. ‘Users with AT LEAST ONE of the selected roles’: At this case you will be asked to

specify the user roles. The page will be available to the users that have at list one of

the selected roles.

c. ‘Users with ALL of the selected roles’: At this case you will be asked to specify the user

roles. The page will be available to the users that have all the selected roles.

If you selected either ‘Users with AT LEAST ONE of the selected roles’ or ‘Users with ALL of the 

selected roles’, specify the selected roles by checking the box next to the roles to which you wish 

to minimize the access: 
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Under the On Permission Denied dropdown, select what kind of message will be displayed in 

case of a denied access. You can choose either the default message by selecting ‘Display the 

default permission denied page’ or  

If you selected ‘Display a Custom error message’ under the On Permission Denied dropdown, 

select the custom message that you wish to be displayed. 
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Under the Show in Navigation dropdown, select either ‘Yes’ or ‘No’. Note that there is another 

Show in Navigation dropdown box in the General tab. In order to set up this setting correctly, 

you need to have in mind the following rules: 

a. If you selected ‘Yes’ in the General Tab and ‘No’ in the Permissions tab, the page will not

be shown in Navigation.

b. If you selected ‘No’ in the Generals Tab and ‘Yes’ in the Permissions tab, the page will not

be shown in Navigation.

c. If you selected ‘No’ in both tabs, the page will not be shown in Navigation

d. If you selected ‘Yes’ in both tabs, the page will be shown in Navigation.



 83 | P a g e

Click Save at the bottom of the page. 
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Page Content Boxes Tab 

Under the Page Content Boxes tab you are able to create content boxes to be displayed on your page. 

Creating a Page Content Box 

Select New Page Content Box that is located next to the yellow star on the upper right of the 

page. 

General Details 

Enter, into the Internal Title field, the name of the content box. 

Under the Type dropdown menu select the type of the content box which can be either ‘Image 

and Link’ or ‘Text’. 
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Under the Location dropdown menu select the location of the content box on the screen which 

can be either at the ‘Right Column’ or at the ‘Left Column’. 

Type: Image and Link 

If you selected ‘Image and Link’ as the type of the content box: 

Click Choose a File to select an email located in your PC. Under the button you can view the 

different image formats that you can select. In case that you want to replace the image you 

chose, just click the button again and select another image. 

Enter, into the Website field, the link that you want to be displayed. This can be either a link or a 

file. 

 In case that the link is an external website, type the link of the website.

 In case that the link will be a website file or a website page, use the link button at the right
of the website field.
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a. From the pop up page, select either Link to Page or Link to File tab and select the

page or a file you wish to add as a link.

b. If you want to remove your selection, use the remove button at the right of the

Website field.

Under the Open With dropdown, indicates whether you want this link to open in a ‘New 

Window’ on in the ‘Same Window’. 

Click Save at the bottom of your page. 
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Type: Text 

If you selected ‘Text’ as the type of the content box 

Enter text you wish to be displayed into the content box in the Text section. 

Notes: 

 You can make the content box bigger or smaller by using the arrow (click, hold and drag) at
the bottom right of the box.

 You can use the content box in full screen by clicking on the full screen icon that is available
in the toolbox. You can use the same tool to exit the full screen.

 For more details on how to use the editor, you can refer to Managing Page Content
section.

Click Save at the bottom of your page. 
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Editing a Page Content Box 

Select the Pencil icon located to the right of the content box you wish to edit. 

Edit the content box fields. 

 Once you have made the desired changes, click Save at the bottom of the page. 

Removing a Page Content Box 

Select the Trash icon located to the right of the content box you wish to remove. 

You will be asked to confirm that you wish to remove the content box. Click OK. 



 89 | P a g e

Editing a Static Link 

In the case that you selected Static Link for the type of your page, you can use the following instructions 

to setup your page. 

From the main page of the administrative website, select your website, located under the 

Manage Websites box.  

Find the page you wish to edit and select the Pencil icon located to the right of the page. 

 At this point you will be able to edit your page. 

General Details 

Enter the Name of your page. 
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Under the Type dropdown list, select ‘Static Link’. 

Enter, into the Website field, the link that you want to be displayed. This can be either a link or a 

file. 

 In case that the link is an external website, type the link of the website.

 In case that the link will be a website file or a website page, use the link button at the right
of the website field.
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a. From the pop up page, select either Link to Page or Link to File tab and select the

page or a file you wish to add as a link.

b. If you want to remove your selection, use the remove button at the right of the

Website field.
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Under the Open With dropdown, indicates whether you want this link to open in a ‘New 

Window’ on in the ‘Same Window’. 

Under the System Page drop down list, select ‘Yes’ if you want to be able to delete the page, 

otherwise leave it as ‘No’. If you mark ‘Yes’, whenever you want to delete the page, you must 

edit the page and set this field to ‘No’. 

Under the Enabled dropdown, select ‘Yes’ if you want the page to be available on your website, 

or ‘No’ if you plan to enable the page at a later date. 

Version Control 

Use the version control if you would like to view any of the previous revisions of your page. 

If the current editing of your page is an important change, select ‘No’ under the This is a minor 

edit dropdown. 
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Managing Page Content 

From the Page Content Toolbox, we’ve selected and explained the tools you are likely to use the most. 

Format and Style dropdowns 

Once you have entered your content, you may want to assign different headings to different parts of 

your text. You can do that using the Format dropdown. 

1. Highlight the text you wish to format.

2. From the dropdown, you can choose from a number of style types.

3. Experiment with the style options and select one that fits your purpose.

Insert/Remove Bullet or Numbered List 

The Bullet and Number tools may be used to assign bullets or numbers to a list, or to remove them. 

Simply highlight your list and click the desired tool. 

1. If you have entered a list of items and would like the items to be bulleted, simply highlight the

list and then select the bullet icon from the page content toolbox.

2. If you have entered a list of items and would like the items to be numbered, simply highlight the

list and then select the numbering icon from the page content toolbox.

Decrease and Increase Indent 

These tools should be used to increase and decrease indents in text and images within your content. 
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Text Color 

The Text Color tool can be used to change the color of your text. However, in order to preserve the 

overall colors and theme of your website, we recommend that you do not change the color of your text 

unless it is absolutely necessary. 

Background Color 

This tool can be used to highlight your text. 

Insert/Edit Table 

Tables can be used to help organize information. To insert or edit a table, simply click this tool. 

1. Within the content entry field, use your cursor to select the location where you’d like your table

to appear.

2. Select the Insert Table icon.

3. Determine the required number of rows and columns your table will need and enter them in to

the corresponding fields.

4. If your table should need a header, select an option from the Header dropdown. You may select

whether you’d like your header to display in the first row or first column. You may also choose

to have no header at all.

5. If you’d like a border for your table, enter a number in the Border Size field. Enter 0 for no

border, or increasing numbers for more pronounced borders. We recommend going no higher

than 3.

6. From the Alignment dropdown, select whether you’d like the table to appear in the right,

center, or left of your page.

7. To caption your table, enter your desired caption in the Caption field.

8. If needed, you may adjust the width and height of your table by pixels.
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9. Cell Padding will determine the space between the cell wall and the cell content. You can adjust

these numbers until you find a combination that suits your needs.

10. The Cell Spacing field is where you can experiment with the amount of space that exists

between the cells themselves.

11. Click OK when you are done creating your table.

12. Once you have created the initial table, you may edit it by right clicking the table and selecting

Edit Table.

Insert Symbol 

The Insert Symbol tool can be used to insert special symbols not found on keyboards. 

Browse Images for your Organization 

You will use this icon to insert photos or graphics onto your page. Note: In order to insert an image into 

your page, you must first add upload the image to Website Files. 

1. Use your cursor to select the point in the content field where you wish to add an image.

2. Select the Image icon to browse images from your website files.

3. Go to the Select Image tab of the Image popup window.
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4. Choose the file you want to add from the files that are in your website files and click OK.

5. Under the Image Info tab you will be able to Preview the image you selected.
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6. Enter an Alternate Text that it will be displayed on mouse over. Otherwise the URL will be

displayed.
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7. You are able to change the following settings of your image:

Width and Height: You can resize your image by changing the default width and height but it is

recommended that any resizing to be done outside the SiteViz, before adding the image in the

Website Files. To allow the dimensions to respond to the screen proportionally, you must leave

these values blank, so it uses the image original height and width.

Border: Enter a border to the image. The default border size is set to zero (0).

HSpace: Change the horizontal space of your image, which is the white space between the

image and any other content at the right or left of the image. The default border size is set to

zero (0).

VSpace: Change the vertical space of your image, which is the white space between the image

and any other content above or below the image. The default border size is set to zero (0).

Align: Under the align drop down, select where you want to place your image. The default is set

to be the left of the screen.

8. Click OK at the bottom of the window.
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Insert a YouTube Video 

You will use this tool when embedding YouTube videos onto your page. 

1. Use your cursor to select the place in the content field where you’d like your video to appear.

You can do this by selecting a point in the text, or by inserting a table. (See Insert/Edit Table

instructions.)

2. Select the YouTube icon from the Page Content Toolbox.

3. Paste in the URL of the YouTube video you wish to feature on your page.

4. Select a size and color scheme for your video.

5. Click OK.

Insert Text Anchors 

This tool allows you to create text anchors. Text anchors are used when you need to create a hyperlink 

to an item that’s further down on a page. 

1. Within the content entry field, use your cursor to select the location where you’d like to place

your text anchor. Then select the Insert Anchor icon.

2. Enter a name for the Anchor, then hit ‘OK’

3. Highlight the text that you’d like to have link to the location of the anchor you’ve created. Then

select the Hyperlink icon.

Hyperlink to another page or file 

This tool allows you to create or remove in-text hyperlinks to other webpages (either inside or outside of 

your website), or to documents or image files.  
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1. On the Edit Page screen, use your cursor to highlight the text you wish to link.

2. In the Page Content toolbox, select the Link icon, located to the right of the YouTube icon.

3. You will need to select a tab depending on the type of link you will be linking. You may link to an

external site or email address, a file, or another page within your website. See instructions

below.

Link to a URL, E-Mail or Anchor 

1. Select the Link Info tab.

2. From the Link Type dropdown, select ‘URL’ if you are linking to another website, ‘Anchor in this

page’ if you are linking to an anchor and ‘E-Mail’ if you are linking to an email address.

3. Enter the URL or email address in the specified field or select an anchor.

4. If you choose URL, you will have a Target dropdown menu. This will determine if your link will

open in the same window or if it will open up in a new window. To open in a new window, select

New Window. To open in the current window, select <not set>.
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5. Click OK.

Link to File 

Note: In order to link to a file, you must first upload that file to your website files. 

1. Select the Link to File tab.

2. From the files directory with all the files in your Website Files, select the file you want to

hyperlink.

3. You will be redirected to the Link Info tab. Under the Target drop down menu, select ‘New

Window’ if you would like your file to open up in a new window. To open in the current window,

select ’<not set>’.
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4. Click OK.

Link to Page 

1. Select the Link to Page tab.
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2. Be sure that the correct website is selected from the top dropdown box.

3. From the pages directory with the pages of your website, select the page that you want to

hyperlink.
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4. You will be redirected to the Link Info tab. Under the Target drop down menu, select ‘New

Window’ if you would like your page to open up in a new window. To open in the current

window, select ’<not set>’.

5. Click OK.
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Manage Website Files 

1. From the main page of the administrative website, select Website Files, located under the

Manage Websites box.

2. Choose under which folder/subfolder you want to add a new file. You can choose an existing

folder/subfolder or add a new folder.

Adding a New Folder 

1. A new folder can be added either as a subfolder of an existing folder, or as a root folder. Click

Add New Folder

2. Enter the Name of the folder.
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3. Click Save at the bottom of the page.

Adding a New File 

1. Under the folder that you want to add your file, choose Add New File.
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2. Enter a Name for your file.

3. Click the Choose a File button to browse your PC for a file. The file formats that are accepted

here are listed under the button.
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4. In case the file you chose is an image file, you are able to resize, sharpen and blur the image.

5. Click Save at the bottom of the page.
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